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Introduction
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Welcome to audiobook 101 for indie authors. My name is Buck Flogging, author of a crapload of

books under multiple names and narrator of 25 audiobooks and counting. In this book you’ll 

learn the basic things that you will need to do in order to produce an audiobook from a 

manuscript, preferably yours. If you are an aspiring professional audiobook narrator, this 

probably isn’t the book for you. For true, professional-grade work you’ll probably want to get 

better equipped. But for independent authors who self-publish their material, and who have little 

to no interest in the ins and out of the voiceover industry, the guidelines outlined in this book 

should help you get it good enough to pass. By pass I mean people will buy it and not complain 

about lousy sound quality.  

Hey, I would love to have Morgan Freeman narrate my books, too. As self-published authors 

interested in perhaps making an extra few hundred bucks a month by listing a book on Audible 

and iTunes, that’s not really in the cards now is it? Even paying Jack Noname, the mediocre, 

nobody’s ever heard of him voiceover guy is still going to be way out of your budget. Spend 

$4,000 to get an audiobook made that’s going to take you a year and a half to break even on? Too

risky. Not worth it. 

So, sometimes it just makes sense to do it ourselves. And the good news is, you can totally tap 

into the audiobook market with a book you record and master yourself. Like I said, it may not be 

perfect, certainly not Morgan Freeman narrating that penguin movie, but with a week’s work and

$50-100 for a good microphone, you can definitely get in the Audible game. 

This book will help you decide on whether or not producing an audiobook is a good use of your 

time, and if you decide it is, it will guide you on the basic steps to getting it to sound as 

professional as it can (without paying any professionals!).



We’ll also give you the scoop on how you can get your book narrated at reasonable cost and save

yourself a lot of trouble if the task of doing it yourself is too daunting.



Is an Audiobook Right for You?
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Of course it is! What, you think we put this little book together to tell you that making an 

audiobook is a BAD idea? Audiobook sales are expected to grow from an estimated $200 million

in 2013 to $750 million in 2016. At least, that’s what I thought I read in Tom Corson Knowles’s 

book, Secrets of the Six-Figure Author. I was never good at figuring out pie charts though. Yeah I

read that book, shut up. I am a six-figure author so back off man! I can read whatever I want. I’ll 

read Phil Jackson’s Sacred Hoops if I feel like it. You should read some of Tom’s books, too. 

Every self-published author should read them. 

I personally feel very hopeful, nay, excited, about the audiobook market. Smart phones come 

with an Audible or iTunes app already installed. Every new car has a port for your phone or 

iMP3Pod or whatever they call those things. It’s just getting easier and easier to listen to books. 

So why wouldn’t you? Reading is hard on the eyes anyway. And we are doing so much of it 

these days on computer screens that audiobooks provide a nice reprieve. 

Plus, although you can read an eBook on a smartphone, it’s still too small to be fun and totally 

kills your battery life. Listening does not. And who wants to carry around both a smartphone 

AND a book or eReader? With just one device and some ear buds you can still get your story on 

wherever you may be. And then there’s driving of course. Listen while driving—yes. Read while 

driving—no. 

Okay I’ll stop. But I will say that I was fully convinced of their potential long before I saw any 

sales predictions on audiobooks, and the sales predictions are outrageously good.  

In terms of ACTUAL sales figures, this is what I’ve seen recently:

• December 2013: 110 audiobooks sold
• January 2014: 155 audiobooks sold
• February 2014: 255 audiobooks sold



Growth I tellz ya!

General trends and forecasts aside, this is what I believe based on my personal experience with 

selling audiobooks…

You can probably count on adding about 10-20% total revenue to the sale of a book by listing it 

with ACX (Audiobook Creation Exchange), which lists the book on Amazon, Audible, and 

iTunes. So, if you are making about $1,000 per month on your book currently, publishing it in 

audiobook format should bump that up to $1,100-1,200 all other variables equal, although some 

books are a lot more conducive to becoming an audiobook than others. There are some strategies 

that we’ll discuss that can bump that significantly higher as well.  

That said, in some cases, as with one of our projects, The Genie Within you may end up striking 

a chord with listeners and earning more with your audiobook than in paperback and Kindle sales 

combined, all without doing much active promotion. 

Like eBooks or paperbacks published through Createspace or something similar, you will get a 

commission on all of the sales of your books. If the buyer entered through an affiliate link of 

yours, you’ll get a little extra commission on top of that—same as what happens when you send 

someone from your website to Amazon to buy a book through an Amazon Associates affiliate 

link. Nothing new there. But unlike eBooks and paperbacks, there are several innovative and 

lucrative ways to make money off of the sale of audiobooks. 

One way to make more off of the sale of your audiobook is to take advantage of Audible’s great 

affiliate program. Audible has a 30-day free trial. If you send someone to the site to get your 

book (or any book for that matter) through your affiliate link, and they sign up for the free trial, 

you get $10. If they go on to become paying members, that jumps up to $25. Not bad. So if you 

have a big audience, a big subscriber list, a huge social media following, and so on—you’ll 

likely be able to generate much more than a 10-20% bump in total revenue. 

Another way you get paid is when your book is the first book downloaded by a new Audible 

member. When that happens, you get a $50 bounty. Yes, $50!. This is another huge game-

http://www.audible.com/pd/Self-Development/The-Genie-Within-Your-Subconscious-Mind-How-It-Works-and-How-to-Use-It-Audiobook/B00HST92G4/


changer regarding audiobooks, and is why I think nearly everyone should go to the trouble of 

turning every manuscript into an audiobook. 

For example, my best-selling book, Eat for Heat, is just a teeny tiny 20,000 words or so. I 

typically sell it for just $2.99 on Kindle for a royalty of just over $2. It’s also available to be 

borrowed through the Kindle lending library, which gets me about the same $2 every time 

someone borrows the book. 

In January of 2014 I sold about 750 Kindle downloads including borrows—about $1,500. 

In comparison, I sold 40 Eat for Heat audiobooks in the same sales period. Not many in 

comparison, but this is why I think audiobooks are PFE (Pretty freakin’ exciting)…

Audible prices books based on the length of the recording. Eat for Heat is a short one so it is 

priced at Audible’s lowest price point, which is $6.95 as of this writing. Already I get over $3 per

copy (40% commission rate if published exclusively through ACX, which is what we 

recommend), which is more than I get from Kindle sales. The cool thing is that out of 40 copies, 

a remarkable 4 qualified for the $50 bounty. That’s an additional $200. Thus, I made somewhere 

around $350 total off of just 40 book sales. That’s almost $10 per copy! Plus I got affiliate 

commission of over $100 that month as well. 

Keep in mind that I am a nonfiction writer, and write mostly health and nutrition-related stuff. 

Even though fiction generally sells better, some nonfiction genres perform better than others. 

And in some ways nonfiction is superior to fiction because of the reduced competition and 

because nonfiction books tend to be shorter. This means faster production and turnaround time, 

and a lower final price, reducing buyer hesitation and generating more sales.

“Once upon a time there was a polyunsaturated fatty acid…” 

Well, boring stuff to listen to when it’s someone other than me narrating. No matter what I read, 

listening to my voice is like making sweet love to a schoolboy. 



Oh come on! Movie reference. I would never. Dumb and Dumber? Jim Carrey? You guys had to 

have seen that one. Anyone? 

So perhaps, considering my genre, these numbers are a little low. Your outcome might be better. I

know one book that I narrated, The Genie Within by Harry Carpenter, is more of a self-helpish 

type of book with guided hypnosis, making it much more enticing as an audiobook than the 

kindle and paperback versions of it. It sells better than any of my audiobooks, yet I sell triple the 

amount of kindle books that Harry does. I’m pretty sure with the right strategy, Harry could 

make more revenue off of his audiobook than his kindle and paperback versions—if he were so 

inclined. 

I don’t know where exactly to fit this next discussion, but I wanted to point it out somewhere, 

and that is audiobook length and pricing as a deciding factor. This is more important to take into 

consideration if you are paying someone to produce your audiobook, but it’s still something 

worthy of pointing out even for the audiobook self-producer. Like most things in the self-

publishing game in the year 2014, the advantage goes to the “short, cheap, and plenty of it” 

strategy. 

You get a $50 bounty for the sale of a book from a new audible member. You trigger more sales 

of a cheap book than an expensive book, with more opportunities at a bounty. Audible prices its 

books based on length. I don’t know exactly where the cutoffs are, but I think anything less than 

an hour is currently $3.95, and anything between an hour and somewhere between two and three 

hours is $6.95. Longer than that and price takes a big jump up to $14.95. 

First, think about what a customer sees when browsing your book on Amazon. They will see a 

Kindle price, a paperback price (if you have one), and an audiobook price. If you’re going to sell 

a lot of audiobooks, and you should aim for that because, like I pointed out earlier, you’ll 

probably get more money per copy sold (and also provide the customer with a much more 

intimate experience—especially if you narrate it yourself)—then you want the price to be in the 

same ballpark. 



I consider 20,000 words to be the magic number for book length these days. This gives you a 

book that will come out just long enough to justify paperback production (for extra sales), and 

the book will be just short enough to come in at $6.95 on Audible, which will probably be even 

cheaper than what you price your paperback. If someone has any inclination to hear the thing as 

an audiobook, $6.95, priced less than the paperback version even, is a steal. They’re in. 

It’s also a small enough price that you can give a customer that little bit of extra motivation to 

maybe go ahead and finally become an audible member—buying yours as their first for a $50 

bounty. 

And, most importantly, a 2-hour audiobook isn’t expensive to have done for you, nor is it such a 

big chore to do yourself. Hell, I turn out a fully polished, edited, mastered, 20,000-word 

manuscript to my clients for just $500. A longer audiobook that’s priced higher and sells fewer 

copies, generating fewer bounties, might cost you $1,500 to pay me to record. 

If that was confusing, the summary is simple. Got a 100,000-word manuscript? You probably 

shouldn’t do an audiobook or pay someone else to do it unless you are doing it based on a royalty

split with a narrator (no up-front costs) or unless that book is riding high on the bestseller lists 

with dozens of sales per day in Kindle and paperback. 

Got a 20,000-word manuscript that’s selling a few copies a day? Better turn that into an 

audiobook ASAP. It’s a no-brainer. You can’t lose unless you narrate the thing drunk while 

chewing gum in an empty hallway. 

So I guess that’s it. I just wanted to throw a little straight talk at you and let you know the things 

I take into consideration before deciding whether or not a book is a good candidate for 

audiobook production. 

It might be smart to produce an audiobook. It might not be. This is not a book about getting you 

so psyched out of your mind, dollar signs in eyes, that you start humping Rob’s leg for showing 

you the technical tips that are going to make your future riches possible. No need to get crazy, 



putting down a bunch of money to get that swimming pool put in, anticipating that big Christmas

bonus from Uncle Audible. 

Another movie reference and you missed it. Fine, enough with the movie references. You guys 

aren’t even getting them. And my silliness is starting to get weird.

But I wanted to be real with you about what you can expect. You won’t get a whole roast turkey, 

but you’ll make a little gravy. It’s worth it for just about every author to go ahead and just blast 

the audiobook out along with the Kindle version (and print-on-demand through Createspace). It’s

better than a 1-year subscription to the jelly of the month club for sure.  

Damnit man! What’s with these movie references? I can’t stop! These fingers have a mind of 

their own when they start pressing away on the keyboard. 

Financially it’s an easy yes for most authors. Even indie authors. Yes you probably read that it’s 

not worth it on a blog or two somewhere, but times are changing. Is it worth the hassle and cost 

though? 

In the remaining chapters we have a looksee at what is involved and see if audiobook production 

is truly for you. Promise no more movie references. 



Recording Equipment and Programs
back to top

We could talk about more advanced equipment, but really, most of that is superfluous unless you 

are really planning on your book being a runaway bestseller. Only then is it going to get 

scrutinized for every tiny crackle and pop in your audio recording. And if it does become a 

bestseller, you should have plenty of money to pay Gandalf or somebody like that to narrate the 

thing for you. 

So, considering that you want to put together something quickly, simply, and inexpensively—

you really only need two things in your arsenal…

1. A decent USB microphone
2. Audacity

Audacity is a free program that you can download onto your computer. It works just fine for 

recording. You get your mic set up, plug it into the USB port, and press record on Audacity. It’s 

not a whole lot more complicated than that. This link here should take you to a page for 

downloading the program. http://audacity.sourceforge.net/download/ 

Here. Have a look at this screenshot. This is me opening the program, pressing the record button 

(the red circle), and repeatedly chanting “durka-durka-durka.” Don’t ask me why. Just seemed 

like the most appropriate thing to say in the heat of the moment. 

http://audacity.sourceforge.net/download/


I used Audacity for podcasting and making audio recordings for years before I made my first 

audiobook with the program. For basic recording, it’s about as self-explanatory as it gets. I get 

stumped by technology very easily, and this program is really pretty idiot-proof. And as far as 

free programs go, this is really a fine piece of work. The only complaint I’ve had is over 

audacity’s occasional tendency to freeze up after you have recorded something. It will probably 

happen to you at some point. I stop and save often. The longer you record without stopping and 

saving your work the more likely it is to freeze up on you and crash with your recording 

unsaved. Frustration central. Be careful. You have been warned! 

Okay, let’s talk microphone. Here again, it doesn’t have to be some amazing new $300 super 

mega condenser radio quality microphone. I use an Alesis podcasting microphone that I paid 

around $70 for. If I had it to do all over again I would order what I consistently hear is the 

microphone with by far the greatest overall value, the Blue Microphones Snowball. Go to our 

audiobook help page for links to the Snowball and several other good ones at 

http://www.archangelink.com/audiobooks 

http://www.archangelink.com/audiobooks


These things are usually priced at $59.95, and always can be found for less than $100. Amazon 

typically has the best prices on this particular item. 

This microphone plugs right into any USB port on your computer. Then you just load Audacity, 

press record, speak into the thing, play it back to make sure you weren’t too close or too far away

from the thing when you recorded, and get busy working on recording that manuscript once you 

get the sound how you like it. 

If it doesn’t sound absolutely perfect, that’s okay. There are steps in mastering the audio later that

can clean up many imperfections. But you do want to get the best-sounding recording as 

possible, as mastering audio just makes it sound better. It can’t perform miracles, turning crap 

into caviar. 

But odds are, with Audacity and a Snowball, you’ll be able to get a solid recording. 



That’s literally all you really need to make a near-pro quality audiobook. To hear the level of 

quality that can easily be achieved with this simple setup, go listen to a sample of our best 

finished product yet at http://www.archangelink.com/audiobooks. 

Not sheer perfection. But it’s clearly good enough to create a very enjoyable listening experience

for my customers. I doubt it will last as it just came out and doesn’t have any bad reviews yet, 

but at the time of this writing it was good enough for a solid 5 Stars for “Performance.” With the 

recording tips that I have to share with you, and the editing and mastering instructions provided 

by Rob soon-to-follow, you too will be able to pull it off no problem. 

Unless, of course, your voice sounds like a perfect blend of Bobcat Goldthwait and Gilbert 

Gottfried. If that’s the case, better stick to printed books only. Or grab your checkbook and give 

Morgan a call. No not the personal injury lawyer. The old black dude with the freckles. 

Mmmmust, resist… movie reference…

Dang that was close, but I resisted. Redemption after the last chapter.  

http://www.archangelink.com/audiobooks


Tips for a Better Recording
back to top

This is all pretty common sense stuff that you would soon discover on your own as you tried to 

make a clean-sounding audiobook. But I will save you some frustrating and time-consuming 

personal discoveries by giving you a few simple tips that will keep you from making the same 

mistakes I did. Here goes…

1.  Don’t get too close to the microphone. If you do, it will make a lot of “pops” when 

you pronounce the letter “p” in particular. Wow, that was a lot of p’s for one sentence. 

Helps get the point across though. If you are having any trouble with loud pops that 

distort your audio on certain word sounds, it might be worth investing in a very 

affordable piece of audio equipment known as a “pop filter.” You just place this filter 

between you and the microphone and it catches the wind you push out of your mouth 

when you make certain sounds. You can get them on Amazon for $10-15. 

2.  Keep your mouth a consistent distance from the microphone throughout the 

recording. I have trouble staying comfortable while recording. If you fidget and flop 

around a lot when you sit like I do, you’ll need to pay careful attention to this. If you are 

moving your mouth closer and farther and closer to the microphone again and again, the 

sound will be very inconsistent in the end. It really disturbs the flow of the audio when 

the sound changes. Also, any kind of shuffling sound will really screw up your recording.

3.  Record a sentence as many times as you need to get it right. You’ll stumble and 

stutter plenty I assure you. And when you are really having trouble it can get pretty 

obnoxious. Be patient and make sure you read that sentence just how you like it before 

you move on. When you screw things up in your narration you create more editing and 

trimming work, but at least you’ll have a clean cut to use. If there is any doubt about 

whether it sounded right or not, record it again. 



4.  Don’t take too many breaks. There will be subtle differences in the sound of your 

voice from day to day and session to session. I find it best to record in big chunks, not 

breaking a book recording into 20, 30-minute sessions, but more like 5, 2-hour sessions. 

It’s subtle, but it makes a difference. 

5.  Don’t drain your lungs. When a person speaks right after a fresh, full breath they 

will typically speak much louder. Then, when the lungs start to deflate, things get quieter 

and more difficult for other people to understand. A mastering tool called “compressing” 

will fix this somewhat, but it’s still best to keep the sound of your voice as consistent as 

possible, and the amount of air in your lungs is a huge factor to pay attention to while 

you’re recording. 

6.  Practice first. Don’t you dare jump right into recording an audiobook without 

practicing first, or you will probably find yourself having to do it all over again. I had to 

record one of my books three freaking times! Read some short stories out loud. Read a 

novel to your boyfriend or wife for fun and for practice. I read all of Desert Solitaire to 

my girlfriend to practice before I recorded my first. Read a chapter several times and 

listen back to see which one sounds the best and figure out what you did differently to 

make it better. It took me about ten hours of reading out loud to become noticeably better 

at it. There’s a huge difference in quality that any ear could distinguish between my first 

recording and my 5th or 6th. Practice up, become acquainted with recording, and develop 

your own system before you actually sit down to record your manuscript for realz. 

7.  Get a Kindle. I’ve narrated audiobooks reading off of a computer screen, out of a 

paperback, and on a Kindle. Kindle is the clear victor. No sound made when turning 

pages, easy to see, and easy to hold. More importantly, you can move the microphone 

much farther from your computer when recording. The little fans in computers are noisy 

and cause a very slight but noticeable decrease in sound quality. The farther you can get 

away from them the better, so you definitely don’t want to be reading off of a computer 

screen to narrate. 



8.  Read in a small, quiet, carpeted area. You obviously want the room you record in to

be as quiet as possible. Cars driving by, neighbors’ televisions blaring—these things get 

picked up in the background. Read in a closet if you have to. But you want the room to be

small and not too barren. Objects, carpet, blankets, and so forth absorb sound waves and 

keep your voice from echoing off the floors and walls and mucking up your sound 

quality. I usually do all my recording in my bedroom, occasionally having to take a break 

when my douchebag neighbor starts up his motorcycle. 

9.  Kill the air and fans. I live in Florida, so I will actually pre-cool the whole place 

down to a cooler than normal temperature before recording so I can read longer before I 

start to drip with sweat. Air conditioners and fans are foes of the narrator. 

10.  Warm up your vocal cords with rooster noises. Now I know what you’re thinking. 

This nut can’t be serious. And you’d be right. But what’s a guy gonna do, make a list with

nine items on it? Ten looks much better don’t you think? Please don’t make rooster 

noises. Just clear your throat a little and start reading.   

And of course don’t forget the even more common sense stuff—like reading with dynamic 

changes in tone and tempo to keep people from nodding off, and reading at a pace where 

listeners can keep up with you. 

That should do it for me. Now I’ll turn it over to Rob for some more technical stuff on the 

editing and mastering end of things. I will say it now, and I know Rob will mention it again, but 

Rob and I do have a company named Archangel Ink (www.archangelink.com) that will produce 

an audiobook for you if this process sounds too technologically-daunting or time-consuming. We

have done everything we could possibly think of to keep production costs to a minimum while 

still delivering a good quality finished product. As a result, our costs are usually less than half of 

what others charge. We’ve gotten costs all the way down to .03 cents per recorded word 

(references and such, for example, are not recorded words and you are not billed for those), 

which comes out to be around $250 per recorded hour (going rates are $300-$500).  

http://www.archangelink.com/


Anyway, it is our pleasure to instruct you on how to do it yourself. But we can help at least a few

of you out who would rather pass the headaches on to people who already know what they are 

doing. We are unable to take on many projects though, so if you are seriously interested let us 

know right away. 

Or you can reach out to us directly by sending an email to contact@archangelink.com or just 

going to our website and filling out the Contact Us form on the homepage: 

www.archangelink.com 

Thanks and best of luck with all of your writing and recording. See you on Audible! 

- Buck Flogging

http://www.archangelink.com/
mailto:rob@archangelink.com


Audiobook Formatting
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Hey everyone, Rob here. Matt's given you the low down on recording an audiobook and why it's 

such a valuable market to get in on now—before competition gets too tough. I'll just jump right 

in, and assume you have your raw audio files (preferably in WAV format) and are ready to trim 

and master it.

1) Open file in Audacity. 



(Available free online here: http://audacity.sourceforge.net/download/)

http://audacity.sourceforge.net/download/


2) It will prompt you to make a file copy before working on it. Agree to make a copy and 

preserve original.



3) Zoom in using the magnifying glass so you can better see the texture of the audio.



4) Begin listening. You're going to want to pay attention to little ridges not associated with 

spoken content, and minimize the presence of this "noise." 

How?

a) Find a section of the audio with a few seconds without speech. Highlight it, and click 

on Effect → Noise Removal

b) Click 'Get Noise Profile.



c) Then un-highlight that section, and again go to Effect → Noise Removal



d) Click OK, and the program will go through the entire recording and remove the audio 

elements that match that noise profile, ideally leaving just the audio elements we want. 

For a big file, it may take 5-10 minutes to complete the whole process. 

You may also find that you have to do it several times, since the first sample you take may miss 

some of the noise present elsewhere in the recording.



4) Once noise is removed, you can continue the editing. Make sure that there is a block of 0.5 

seconds of ambient background sound before the chapter title is given, and then 2.5 seconds of 

ambient background sound before the content begins. Audible requires this and it is also going to

be useful in the following step.



5) As you're listening, you want to pay attention to and remove the small blips here and there that

remain after Noise Removal. To do this, you can do one of two things

a) Simply highlight the relevant section, then delete. (You need to hit stop on the 

recording to do any edits, including deletions, copying, pasting, etc.)

OR

b) Highlight the relevant section, then hit stop, and Paste a section of dead air of the 

appropriate length over the noise you want to remove.  You can copy this "dead air" aka 

ambient background noise from the start of the recording, as mentioned in Step 4. This 

allows for "dead air" with the same sound profile as the rest of the ambient background 

noise of the recording.



6) The bulk of the audioboook mastering is just paying close attention to how the recording 

sounds, and adjusting what does not sound good.  In addition to removing these blips, this 

includes removing any unnecessary dead air in between sentences/paragraph and any 

redundancies (recording the same section more than once). 

Why would there be redundancies?

a) An initial attempt was misspoken or came out sounding off somehow (most common). 

b) Some sort of background noise interrupted the recording and the narrator had to re-

record (sounds of a book page turning, a sneeze, a cough, environmental noise, etc.)

c) Etc.



*PRO TIP*

Keep the cursor moving and insert it after each sentence that sounds good. That way, if you

come to an error, you can simply press SHIFT + click, and highlight the area since the last

error-free marker, and delete it, rather than having to go back and find the correct point again. A

quick click every few seconds while continuing to listen can save time searching afterward for

the start of each sentence.

7) Occasionally a narrator may editorialize and make comments to the person doing the 

mastering. Note any points of interest, but ultimately remove any part of the recording that is not 

a part of the source text.

8) Pay attention to cadence and flow. I have had to adjust the pace of a section or two when I 

thought the speed was too fast (or too slow). To do this:

a) Highlight the section you want to adjust. 

b) Go to Effect → Change Tempo





c) In the 'Percent Change' box, adjust to between -10 and 10. Beyond that, it starts to 

sound too wonky. Even tighter, between -7 and 7 might be preferable. That's usually not 

too jarring for the listener, but can accomplish the goal of greater listen-ability.

This is one of the elements that requires artistic discretion. Listen a few times if you need to, and 

think about how someone hearing this on an MP3 player or in their car would experience it. 

Is it clear? Does it sound good? Is there any distraction from the content? Ultimately, you want 

the audio to be a non-issue as much as possible, so listeners can focus on the message. All your 

efforts in mastering should be toward that goal.

Keep in mind as well that there is only so much you can do to transform a source file. If one 

section is particularly difficult, the best bet may be to re-record it. As always, your discretion and

best judgment is needed.

9) Another 'more art than science' element: Pauses.  



Think about flow and the listener's experience. Sometimes you want to have a moment to catch 

up with an important concept and let it resonate for a bit. 

How do you do this if the narrator did not include a pause and recording just continues right on?

a) That previously copied dead space can be inserted between sentences/paragraphs. It 

may require some finesse to get the placement just right so that the last breath of the 

previous sentence doesn't show up after a 0.5 second pause at the start of the next 

sentence. Just be attentive and work with it as best as you can.

How much of a pause is best? That depends. At the start of a chapter, 2.5 seconds may be just 

right, but that same 2.5 seconds can feel very long between paragraphs. So you might want to 

copy a 0.25-0.5 second clip of dead air, which you can then insert consecutively, multiple times 

if necessary, to create longer space, but only once if you need a briefer pause. There are no hard 

and fast rules--your good judgment is key.



b) REMINDER! Certain parameters required by Audible:  

• Before the chapter name is spoken: 0.5 seconds
• Between chapter name and the start of chapter content: 2.5 seconds 
• At the end of each chapter: 3.5 seconds 

10) Your narrator may announce "New Chapter" and then the chapter name, particularly if he or 

she is recording multiple chapters and a single WAV file.  You can remove this phrase and leave 

just the chapter name. Saying this is primarily helpful in case you are unfamiliar with the source 

text and where the chapter starts and stops and thus where to insert the requisite pauses.

*OTHER USEFUL EFFECTS*

Fade In/ Fade Out: This may be helpful when inserting pauses between words that are too close

together. Fading out the end of the last word before the pause, and/or fading in the first word 

after the pause can offer a more natural rhythm to what may otherwise sound disjointed. You'll 

have to play with this to get it sounding as good as you can. There's no substitute for getting the 

initial recording perfect, but you can use this to good effect and ideally create a final file that is 

indistinguishable from a perfect recording to the average listener's ear.



11) Creating separate Chapter Files:

a) Starting from the end of the Chapter in question, and going toward the beginning of the

master file, highlight the recording. 

b) Make sure the 'Stop' button is pressed. 

c) Click Edit → Copy



d) Go to File → New



e) Click Edit → Paste



f) You'll see the copied Chapter.

g) Go to File → Save Project As



h) If this is the first chapter, you will need to create a new folder for this Audiobook. Do 

so.

i) Then save this Chapter as 'Chap1' or by some other obvious naming system.



j) Go back to the master file and delete the still-highlighted first section.

k) You should now have that master file starting at Chapter 2 (or 3 and so on).

l) Repeat for each chapter until the end.

12) Upon completion of all chapters, give it a thorough once over. Take a day or two to clear the 

process from your mind, and listen with fresh ears chapter by chapter. 

This is your opportunity to make any necessary changes. Make sure it all sounds good and that 

you're satisfied with the mastered product.



13) Once given the all clear, convert to MP3 by:

a) Go to Tracks → Stereo Track to Mono (ACX requires the files be in Mono rather than 

Stereo format)



b) Go to File → Export



c) A 'Save As' menu will appear. Make sure you select the appropriate destination for 

your file (such as your previously created Audiobook folder for that project).



d) Ensure Format at the bottom drop down menu is 'MP3 Files.'

e) Click on 'Options' beside that menu and ensure that Bit Rate Mode is set to 'Constant' 

and Quality is set to 192kbps. If all clear, click 'OK.'



f) Click Save

g) A Menu will appear to insert track Metadata. Input all the appropriate information, 

such as:

• Artist: [Author Name]
• Track Title: [Chapter Name]
• Album Title: [Book Name]
• Year: [Year recorded]
• Genre: Audiobook



Click OK

h) Close out that Audacity Chapter file. 

It will prompt you to see if you want to save the changes. I typically say no, so as to leave the file

in Stereo format in case we need that later. We can always convert back to Mono if we need to 

re-export it as an MP3.

14) Once you've created these MP3 chapter files for every chapter of your audiobook, you are 

ready to upload them to Audible Creation Exchange: 

• Log in to your account, open the project tab for this project, and upload your files. 

Make sure that your narrator has recorded Opening Credits and Closing Credits, and 

select a 1-5 minute excerpt from your audiobook as a retail sample. 

• The opening credits should take the form of:



[Title]: [Subtitle] by [Author]. Narrated by [Narrator] Copyright [Year], [Copyright 

Holder] Produced by [Producer Name]

• The closing credits should take the form of:

This has been [Title]: [Subtitle] by [Author] Narrated by [Narrator]. Copyright 

[Year], [Copyright Holder], Produced by [Producer Name]

15) Once you've uploaded all the files and are sure they are ready to go, submit them to Audible 

Creation Exchange, and they will begin the review process. It typically takes ~21 business days 

to review and approve your material. Once approved, your audiobook will be live for sale on 

Audible, Amazon and the iTunes store, and you're all set to market it and find your audience.

For more assistance, please go to www.archangelink.com/wp/audiobooks. There you will find a 

video that I made that demonstrates each of these steps in real time. 

Thanks for reading and good luck with your recording!

Sincerely, 

Rob and Buck from Archangel Ink

http://www.archangelink.com/wp/audiobooks


Please Leave a Review
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You’ve no doubt received some information in this book that could add hundreds, perhaps even 

thousands of extra dollars to your bank account each year, and you received this great insider 

information for less than $1! As writers we live and die by the quantity and quality of the reviews

we receive. Please do us a small favor by taking just a few minutes to leave a thoughtful review 

right now. You can do that right HERE.

http://www.amazon.com/How-Create-Audiobook-Audible-Formatting-ebook/dp/B00GSX28BM
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Read the entire book on Kindle or listen on Audible

Introduction

Having owned a computer with an internet connection for less than one year, I started my first 

blog. I knew absolutely nothing about blogging or computers. In fact, a week before I started a 

blog was the first time I’d ever heard the word “blog.” It was suggested I start one of these 

“blog” things by a co-worker who had checked out some of my writing and thought the web was 

a good place to get some of my writing out there in the world. 

And blog I did. I wrote post after post after endless post for years. By the end of 2013, seven 

years into this blogging malarkey, over 700 posts under my belt, with a global Alexa ranking in 

the top 90,000 and 5,000 daily visitors to my site, I pulled the plug on it with no warning. 

I worked so hard for seven years to build a blog from absolute nothing to an authority website in 

my niche. Why, after all that hard work to arrive at such an enviable place, would I just hastily 

yank it down? 

You’ll find out in this book. It was not without good reason. 

While blogging is indeed one way to publicize your work, gain some traction in the search 

engines, gather a loyal following of interested readers, and make great connections with people 

in your field, there are other, more efficient ways to do these things. 

Blogging worked for me. Yay. And I wouldn’t trade the lessons learned for anything in the world.

I wouldn’t take back a single minute of my time spent blogging considering what it did for my 

ability to write, communicate with others, think more critically, and otherwise be the beacon of 

pure untouchable awesomeness that I currently am. 

http://www.audible.com/pd/Business/Kill-Your-Blog-Audiobook/B00I2WUKXU
http://www.amazon.com/Kill-Your-Blog-Reasons-Blogging-ebook/dp/B00HWJ2JN8/


But I certainly can’t say that it was the most efficient or sensible approach. In fact, in this book 

you will hear spine-chilling tales of appalling inefficiency. Think one net subscriber for every 

1,000 visitors to the site. Think four years of hard work before my first month making four 

figures. Think having to live at mom’s house for a while. Yeah, shit was dire there for a long time

before I finally “made it.” 

Knowing what I know now, a year would have probably been plenty of time to get where I am 

today. 

My hope by writing this book and putting it out into the world for readers like you to find is not 

really to bash blogging, although I plan on doing that plentifully—mostly for my own 

entertainment. What I really want to do is help you to think much deeper about how you are 

making connections with readers, who you are connecting with, what you are going to do for 

them, and what they are going to do for you. With a little thought in that realm, you’ll be 

outrageously more successful in outrageously less time.  

My biggest hesitation in writing a book like this is that the thoughts I share might help you to 

become too successful too fast. It might be like finding the woman of your dreams at age 15. 

Hey, that’s great. You found her! But you may not be ready to handle that. The best thing about 

blogging, like I’ve already alluded to, is the important maturity and skill-building process. And 

by jumping right into some of the things I mention in this book I fear that you will blow it with 

the woman of your dreams because you haven’t grown out of your childish think-you-know-

everything-but-really-don’t phase. 

Okay, I guess it was just me that went through that phase. 

And lastly, before we begin, please don’t be too thrown off by my writing style. I write for a 

living because I like writing, but I like writing my way. I get silly and use naughty words and 

fake names with fake forewords on occasion because, no matter how serious the subject matter, 

that is really fun for me. And I jump around a lot too because, face it, writing outlines is really 

boring. 



Plus, how would I know what I’m going to say before I say it anyway? Most people write books 

to let people know how they feel about something. I write books just to find out how I feel about 

something! 

So, without further distraction, let’s all read on to figure out why I think blogging should be 

killed. And why I executed my blog.   



Chapter 1 Amazon Kindle

If I was feeling lazier, I would have just written one reason to stop blogging, and Amazon Kindle

would be it. End of story. 

In fact, after writing that sentence and reflecting on it. I was tempted just to end the book right 

there. 

In October of 2012, after selling eBooks on my own site for almost four years, I decided to 

finally test the waters at Amazon. I thought Amazon was this big place where Tim Ferriss and 

Malcolm Gladwell sold nonfiction books while everyone else made about a dime per year. But I 

was willing to check it out and see. 

What I wanted to see was what would happen if you just put a book up for sale over there with 

no real promotion. I told absolutely no one about the book I listed over there (and at Lulu). And I

mean no one. No links from my site, nothing to the list of seven subscribers I had built over six 

years, nothing on TwatFace or YouTube. Nothing. 

At the end of the first month, I had made about $200 in royalties. That’s about the same as what I

made on that same book telling freaking everybody about it on my website and its 3,500 or so 

daily visitors at the time. It was better than I expected, and considering that I had over ten books, 

I did a little math and decided that the worst-case scenario was $200 * 10 books * 12 months = 

$24,000.  

In the first year I did indeed make lots of money, even more offsite than I made onsite. And that’s

with a big website with big traffic and nearly 100 affiliates. I did far better than any worst-case 

scenario I might have imagined. And I got to witness the beautiful selling machine that is the 

Kindle store. 

Imagine that! I put a book for sale at a place where book buyers go to shop for books, and I sold 

more than I did trying to sell a book to a bunch of blog browsers aimlessly cruising the internet 

and finding some random old blog post of mine. 



And boy was working with Amazon tough. Jeez, I had to have somebody format a book for me 

for cheap and put it for sale over there. Ahh the difficulty! Before I could just make a PDF, but 

now I had to make a MOBY Dick Pube file or something. 

“How will I ever figure it out?” I thought. 

And then I remembered there was this internet thing that answers all questions you have in a half

second. Problem solved. 

I know it sounds ridiculous, but it never really even occurred to me that I should put my books 

on Amazon, the place where like, 60-something% of all books are bought and sold. It never 

occurred to me to try to reach out and build an audience at a place where everyone who is 

looking for information is willing to pay for that information. I thought I’d make more money 

selling to people that weren’t looking for books or to buy anything at all??? 

Guilty as charged. 

But a year of selling on Amazon and I fully came to my senses. Honestly, all that traffic from 

Google really did for me was make me feel cool when I checked my site ranking on Alexa. 

That’s really about it. It didn’t build many subscribers, it didn’t build many social media likes, 

and it didn’t drive many sales. Some. But not many. Like I said, the key word to remember here 

with blogging is “inefficient.” 

And having a website in the top 100,000 in the world is pretty cool. But I’m a writer at heart. I 

even went to school for it, meaning I knew even at 21 that I wanted to write. So I found it much 

cooler on December 27th, 2012, 28 days into listing all my books on Amazon, that I was the #404

ranked author on the face of the planet. Well, planet Amazon at least. I was king for a day, ahead 

of my evil nemesis Tim Ferriss for a brief moment. 

So I’m all about Amazon and books, not Google and blogs. Who cares about Google? I want to 

show up high on Amazon where information shoppers linger. Also, writing books, as opposed to 

blog posts, is a much better way to organize information. Readers all start on the first page and 



you can take them on a logical journey from A to Z. With a blog, who knows where they are 

going to hop on the ride? Most people that landed on my website just got confused and left. With

a book you get a chance to properly explain things from square one. 

Most importantly, why write mediocre content in the form of a blog post when you could write 

excellent content that you really spend a lot of time on in the form of a short book? And get 

instantly and directly paid for it? 

Okay, okay. Let’s talk a little bit more about Amazon in depth. Many of you probably know all of

this, but the following is the quick and dirty for how Amazon works and why it works better for 

me. 

The Case for Amazon

Most bloggers think of taking on a book project as kind of intimidating. While most bloggers 

will write the equivalent of several full-length books full of blog posts and comments over the 

course of a year, a book still feels like a bigger undertaking. 

Please don’t psyche yourself out. Just because it’s called a “book” doesn’t mean that it’s got to be

an 800-pager like one of those Harry Frodo books. The books of today are short, particularly 

those put out by self-published authors with good business sense. 

Obviously you don’t want to write three paragraphs and call it a book. Customers are going to be

very dissatisfied and never buy anything from you again. But average book length is getting 

shorter and shorter with average price getting lower and lower. There’s no need to try to blow 

your whole wad on some masterpiece. Just tackle a simple topic, keep it tight, provide some 

value, undercut the competition on price, and move on to your next area of interest. I think 

20,000 words is about the perfect length for nonfiction. But even novels, which are almost 

always over 50,000 words, should be shorter and broken up into a series. 

Got a 100,000-word book in the works? Great! Break it into a series of five books and sell each 

for $2.99 or less. More profits guaranteed, more exposure guaranteed, and you still get to string 



along an audience in a bloggy kind of way if that’s your thing—just giving a taste and keeping 

them hungry for the next episode (and not waiting too long for it). Your audience will be 

whipped into a jellylike foam in eager anticipation of the next episode, similar to the TV show 

model. Nobody takes a whole season of shows and puts it into one, 10-hour episode. That would 

make no business sense whatsoever. And it makes little to no sense, barring unique 

circumstances, to make a reader slog through 15 hours of reading to get through a single book. 

It’s better to break it up and build your library of titles as an author. 

Here is how I use Amazon to outperform the results I got blogging…

Instead of blogging, I now just have a page on my site where people can subscribe to get access 

to a monthly newsletter and an email-delivered eCourse that I have created. Instead of having a 

subscriber conversion rate of 0.1%, now I have a subscriber conversion rate of 15% and am 

testing out ways to make that better. I literally get 150 subscribers for every thousand visits to my

site compared to one per thousand during my seven years of blogging. Right now I’m getting a 

lot more subscribers off of a lot less traffic. More importantly, I know the things that I do to send 

traffic to my site are actually going to pay off with my new system. 

So now, instead of writing “posts” on my site to get traffic and no subscribers, I just set one of 

my books to FREE in the kindle store through Amazon’s KDP Select program. In each book I 

have lots of links back to my site offering my eCourse, newsletter, and more free books, as well 

as a promotion of my other books. And when I set my books to free I get tons of exposure. 

My first free book managed to get 19,500 downloads in its five free days through KDP Select 

(you get five free days every three months). I got 1,200 new subscribers on my website, sold 

50% more paid books during those five days with a residual boost in sales lasting weeks after, 

and that book went from selling only one copy per day to regularly sitting pretty at #1 in its 

category (Eating Disorders).

It was a huge win-win, and with seven books in that niche and more on the way, I can run a free 

book nearly half the time. There I am, building a great subscriber list of Amazon eBook 

customers that like my work and are ready to scoop up more titles. 



Hopefully this gives you a glimpse of how powerful and efficient this strategy is compared to 

blogging in terms of making money for your writing. Keep in mind that I equate affiliate sales 

and advertising as a form of dishonest whoring for the most part, so if you rely on such activities 

to monetize your blog, this may not work for you at all. As someone who wants to make money 

for writing, not from writing (subtle but big difference), this model is vastly superior. 

The other beauty of this model is that, as this big loop continues to roll, I create a larger and 

larger launching platform for new books. This, in and of itself, is enough to make it all 

worthwhile. 

Amazon wants to sell stuff. So it knows what books are selling and shoves those top sellers into 

the faces of customers. To get that kind of status in Amazon’s algorithm, you have to prove that 

you can get lots of sales and lots of reviews. If you can do that, Amazon will go to bat for you 

and sell your books. Having a pre-established audience to use as rocket fuel for a book launch is, 

quite simply, everything when it comes to success on Kindle. 

Even with a pretty tiny audience, in June of 2013 I launched a brand-new book of mine at 99 

cents, sold about 1,800 copies in the first two days, and got all the way to #1 Hot New Release in

Nonfiction. I’ll take it. I got lots of reviews, great visibility and overall status as being a BDP in 

my field (I use BDP a lot, explained in this 10 second video… http://www.YouTube.com/watch?

v=GZa_5k937hg), and sales of that book have been quite decent ever since. That big release had 

somewhat of a permanent beneficial effect on my book’s ability to rank well and show up. 

Now my audience is growing rapidly. 600 people just requested to review my next book in 

exchange for a free review copy. Yeah, that book’s gonna sell well. And things are only going to 

get bigger. Keep in mind, the vast majority of the people I’m building in my network of 

subscribers and social media are Kindle customers, and that counts for a lot because not 

everyone is a Kindle customer yet. 

Kindle owners buy something like six times as many books as those who do not have such a 

device. And that’s the kind of targeted list-building that anyone in book sales should be trying to 

build. I couldn’t be happier. Had to write a damn book about it I’m so pleased. 

http://www.youtube.com/watch?v=GZa_5k937hg
http://www.youtube.com/watch?v=GZa_5k937hg
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“Giving you the Buck-naked truth about online entrepreneurship.”

Hi I’m Buck Flogging. Hell yeah that’s my real name and that’s totally me in the picture living 

large and driving the ladies wild. 

When I’m not busy squatting 800 pounds for reps and pleasing all those ladies, I’m writing lots 

of books, narrating audiobooks, helping authors publish and successfully sell their work, and 

operating some lucrative online businesses of mine.

I originally started as a know-nothing wannabe writer that was encouraged to start this 

mysterious thing called a “blog.” From moronic mistakes and prolonged poverty I emerged 

seven years later with the success that all online entrepreneurs dream of achieving. 

I hope to find time to write several short books revealing as much of what I’ve learned as 

possible. I love seeing other people succeed, and I hate to see others make mistakes. Spend a 



buck and get some Buck—and save yourself a lot of mistakes that may be costing you thousands 

of dollars and wasting years of your life.  

Rob Archangel here. I think of myself as a journeyman jack-of-all-trades. Several years ago, I 

worked as an assistant to the publisher of the longest running permaculture journal in North 

America, and got my first taste of the publishing world. Long passionate about writing and 

communication, I partnered with Matt (come on, you didn’t really think his name was Buck 

Flogging did you?) in 2012 to expand the reach of his site, www.180degreehealth.com, and 

spearheaded his entry into the eReader and audiobook world. Realizing I have a knack and a 

passion for the process, and that all my time spent learning the ropes could be of value to others, 

I founded Archangel Ink as an umbrella outfit for all one’s independent publishing needs. My 

goal is to help authors find their audience by professionalizing their self-published materials, and

increase their reach by listing each book at all of the viable retailers in every available format 

(digital, print, and audio).

http://archangelink.com/
http://www.180degreehealth.com/
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